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Gantt charts or Gantt diagrams are project management tools used to analyze and plan projects. Gantt charts graphically represent the progress of time for the duration of an operation and are useful for monitoring the progress of a project. In a nutshell, the Gantt chart is a bar graph that shows the schedule of a project, including the start and finish dates of the project element.
Developed in 1917 by Henry L. Gantt, an American engineer and social scientist, the Gantt chart is a horizontal bar chart designed to track specific tasks in a project. Simple Gantt charts can be created on graph paper, or more complex automated charts can be created using project management apps, like Microsoft Project, Share Point or Excel. Gantt chart templates can be
found online. Online project management tools for Business.com small businesses are Claizen, AtTask, and Tenrox. The monthly cost of these tools is $24.95, $39.95, and $38.95, respectively. [Read the full review] When you plan a Gantt chart, certain activities depend on other activities that are completed first. These tasks must be completed before you start another task called
sequential or linear operations. For example, there will be the creation of collateral - it must be done before the distribution of the collateral begins. Another activity that does not need to be performed in a particular sequence is parallel operations. You don't need to do it in a specific order, but you may need to do something else to complete it first. Before drawing a chart, create a
list of all activities in the plan, estimated time, and whether it is parallel or sequential. Displays the dependent stages. It is best to do this with tables to keep your work organized. Now you're ready to create a chart. The Gantt chart contains a horizontal axis that represents the time range of the project and is broken down into days, weeks, or months. The vertical axis represents the
work required to complete the project. Horizontal bars of different lengths represent the time range for each operation. For example, if you are preparing a proposal, the first task might be a performance study at the top of the vertical axis. Draw a bar on a graph that indicates how long the study is expected to take. Enter the other tasks below to perform the research and draw a
representative bar for the time you are expected to spend. Bar ranges can overlap. For example, you can conduct research at the same time as determining a budget, and the bar range might overlap. When the Gantt chart is complete, you can check the resourcing of various activities and timelines to see if the project itself is viable. The Gantt chart provides a big picture of the
project and provides an overhead view to the project manager. As the project continues, add different colors, arrow heads, or other markers. The same task as a partial or completed operation. Gantt charts make it easy for users to monitor the progress of a project. It's easy to see what needs to be achieved at any point in time, and if you expect your work to miss the due date, you
can take action to get the project back on track. One major problem with the Gantt chart is that it does not represent a task dependency. If one task does not reach the schedule, how does it affect the other? Another project management chart tool, THE PERT Chart, is an alternative designed for this purpose. Automatic Gantt charts created with software typically store more
information about the task. Programs like this make it easy for gantt charts to make changes to the charts by the individual, the procedures, and the user assigned to each task. Gantt charts are dynamic tools - if the project is almost unkept with the original plan, we expect the chart to be adjusted frequently to reflect the actual state of the project work. Microsoft PowerPoint is one
of the most commonly used tools to present plans, suggestions, or reports to high-level leads. The tool does not have built-in Gantt functionality, but professionals who need to include gantt charts in their presentation have the option to build and edit directly inside PowerPoint. The first option is to use the tool's stack bar feature and a bit of formatting to manually make Gantt, while
the other allows you to automatically generate graphics using a simple PowerPoint plug-in. On this page, I'd like to show you both ways to create a PowerPoint Gantt chart. If you want to learn how to build a timeline in PowerPoint, see the timeline tutorial here. What tutorialwould you like to see? How to create gantt charts manually in PowerPoint 1. Create the default graphics by
setting the stacked bar chart as open PowerPoint, select the layout from the Home tab, and select the empty type for the slide. Go to the Insert tab. In the Pictures section, click the chart. Select the bar category from the list of all charts. Select the stacked bar type for the Gantt chart. 2. After completing all the steps listed above, entering the project schedule data, the standard
chart below is inserted into the PowerPoint slide and the pre-filled Excel table with placeholder data can be replaced directly. Quick tip: You can change the style and color scheme of your chart by clicking on the small brush symbol on the right side of the graphic. Before you start working on the Gantt chart, you must first break down your project into the main steps or tasks that
are the basis of the graphics. After defining these project tasks, assign each task a start date, end date, and duration (the number of days required to perform the task). When you insert the job name, the item The top and first actions in the graphic are at the bottom of the graphic, and the last task is displayed at the top. Replace the name of column series 1 with the start date,
series 2 column to the end date, and the duration of the last column to the period (days). You may need to format two columns to correctly display this type of content before entering the date of the project task on the start and end dates. To do this, select columns B and C, right-click, and select the cell format from the menu that appears. In the pop-up format cell dialog box, select
a date from the list of categories on the left, and then select the desired date format from the Type menu. Set the appropriate format for the start and end date columns, and then insert the date for each task. Note: Don't worry if the chart appears to be broken after entering the date. This is normal and will be processed shortly after you create a duration column. To calculate the
duration of the operation, enter the formula =$C 2-$B 2 in cell D2 (the operation that corresponds to the first operation). Then select the cell, and then drag the fill handle (a small green rectangle in the lower right corner of the cell) to the column downwards. This applies the same formula to other cells below the duration column to fill in the appropriate number of days. After
calculating the duration of the task, you can now remove the end date series from the graphic - in this case you can create a space where you can easily see the duration series and make it closer to what the graphics look like. First, select the chart, and then i. Click the chart filter icon in the top right corner of the visual. ii. Uncheck the check box next to the end date in the series
group. iii. Click Apply. After filtering the final date, the chart should now look like this: 3. Format the graphics to convert the accumulated bar chart to the Gantt chart you've built so far. To replace it with a Gantt chart, you need to format the graphics so that the blue section becomes transparent and only the gray section can be seen. The remaining bars represent the work of the
Gantt chart. To do this, click the blue bar in the chart. This ensures that everything is selected at once. Right-click on the selection to open the mini-toolbar. In the mini toolbar, click the fill icon and select FillNo. The Gant chart will now look like this: 4. If you customize the Gantt chart detailing the Gantt chart, you can select all tasks with one click to change the color of all tasks at
the same time, right-click on the selection, right click on the selection, and enter the mini toolbar to select the color of your choice. In my example I chose dark red. To make individual tasks stand out, you can easily recolor each task. If you double-click on the action you want, all you have to do is select the action you want and use the fill to select a new shade. You can also apply
different styles and effects. Use graphics using the chart tool format tab on the ribbon. However, I recommend keeping these effects to a minimum to ensure readability. In my example, I decided to add a shadow to the plot area so that it is more noticeable. You can also revert the task order so that the first task appears at the top of the Gantt chart and the last action at the bottom
is visible. To do this, double-click the task description list on the left side of the graphic. This opens a type axis window under the Axis options group, where the check box before the category must be checked in reverse order. This will tell you that the order of the operations has been reversed and the date marker has also been moved from the bottom to the top of the Gantt chart.
To bring the work closer to the vertical axis of the Gantt chart, you must remove the empty space that had a blue bar. To do so: i. Select the date above the bar, right-click on the selected area, and select the format axis from the small menu that pops up. ii. Adjust the left boundary of the chart by increasing the minimum boundary number below the header called boundary in the
open axis options window on the right. In my case, I changed the initial number from 43200.0 to 43300.0. As a final adjustment, I also wanted to remove the legend from my graphics as I felt it made it more confusing than helpful. To do this, simply select and press Delete. After all, my PowerPoint Gantt chart looked like this: how to automatically create a Gantt chart from
PowerPoint is not that complicated to build a Gantt chart manually in PowerPoint, but it won't take time and effort. To make the entire process simpler and more time-efficient, you can use intuitive add-ons in PowerPoint called office timelines. You can use pre-formatted Gantt chart templates and copy, paste, or import data from Excel and other productivity tools. The steps below
show you how to use the PowerPoint add-on to automatically create gantt charts. To get started, you'll need to install Office Timeline Plus, which adds the Gantt Chart Maker tab to the PowerPoint ribbon. 1. Open PowerPoint and enter your data in the Office Timeline Plus wizard. Go to the Office Timeline Plus tab, which you can see on the PowerPoint Ribbon, and click New. This
opens up a gallery where you can choose from a variety of templates and styles to use for your graphics. Double-click to select the template you want, and then click Template in the preview window. For my example, I use a custom Gantt template I created previously. You can now manually enter tasks and dates in the data entry wizard, or copy and paste them from existing
Excel files. You can also make some custom choices, such as changing the appearance or color of each operation. When you're ready, click the Create button. 2. Depending on the template, a new Gantt chart slide from PowerPoint will be created immediately. And the customization you create, you can get a Gantt chart that looks similar to this: once created, your Gantt chart can
be styled or updated automatically using Office Timeline Plus. You can add or edit data at any time, format fonts and shapes, and include details such as duration of work, percentage of completion, or today's markers. In the example above, we entered a few milestones, rearranged the job title, and added % to provide more clarity. How to create a PowerPoint Gant chart in 60
seconds in Excel: Download video and play free of charge on your office timeline
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